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Chapter 1 – Introduction  
 
 
BRIT Lite is a viewing workbench that provides a Windows solution for screening medical images 
from film digitizers, frame grabbers, image archives or from other DICOM-compliant devices.   
 
The BRIT Lite application can be set up to view images in one of two ways: 
 
� Local Only – for studies that were previously viewed on the computer, where the monitor is 

attached, to be viewed again.  (Some sites automatically delete the study upon exiting the 
application.) 

 
� Web browser – for an interface to the servers where the images are stored over the internet 

using Internet Explorer. 
 

Starting the BRIT Lite Application 
 
To start the BRIT Lite application, click on the Internet Explorer or Netscape Navigator icon on the 

desktop and enter the address (or URL) for BRIT Lite, or click on the BRIT Lite icon (  ) on 
the desktop. 

 
The login window opens.  Enter the user ID and password.  
The BRIT Lite Server address should already be displayed in 
the field under Server.  Normally BRIT Lite is configured for a 
single server connection. 
 
 
 
 
 

 
 
 
 
Once the User ID and Password are entered, 
click on the Login button, the application 
loads, and the window opens as shown here: 
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Patient Select/ 
Work List/  

Study List 

Quick Search Bar 

Drop-down Menus 

Components of the Patient Select Window 
 
The BRIT Lite application displays in a window that is divided into various components, depending 
on the current activity. 
 
Initially, the BRIT Lite application allows the user to get a list 
of all the patients, or search for a patient 
by a variety of criteria.    
 
This window is divided into four main 
sections: 
 
� Drop-down Menus 
� Quick Search Bar 
� Patient Select/Work List 
� Study List Area 
  
This section provides just an overview of 
the components of each window.  For 
further details, see the appropriate section. 
 
 
 
 

Drop-down Menus 
 
There are five menus that provide additional functionality in the BRIT Lite application.  These are: 
 

� File � Patient List 
� Utilities � Image 
� Search � Print 
� Help  

 
 

File Menu 
 
The File menu contains four selections:   
 
� Login – This is grayed out once the user is logged in to 

the BRIT Lite server. 
� Read DICOM PDI CD – This allows the user to import a 

study from a CD 
� Save PDI CD to DISK – This allows the user to save the 

study that was imported from the CD to their hard drive 
� Exit – Closes the BRIT Lite application 
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Patient List 
 
The Patient list… selection is used to get a list of patients that are already downloaded locally or 
when a patient is already selected and the 
study is displayed in the viewing area.  
Selecting Patient list... on the menu toggles 
the window to display the list of patients in 
the Patient Select/Work List portion of the 
window. 
 

Utilities 
 
The Utilities menu contains four selections:    
 
� Hide/Show Study List – Allows the list 

of studies for the patient to display or be 
hidden.  If the list of patient studies is 
shown, this menu selection becomes 
Hide Study List.  If Hide Study List is 
selected, the Study List disappears and 
the area is fully used for the Viewing 
window for the images in the study or series.  This menu selection changes to Show Study List 
if the Study List is hidden. 

  
� Download Status – Displays a list of the Downloaded DICOM files, the list of DICOM files to be 

downloaded, and the failed DICOM downloads. 
 
� Compress Quality – Allows control of the compression class on a case-by-case basis for the 

images depending on the need for teleradiology consultation.  The selection is based on the 
ability of the receiving workstation’s graphical support.  Typically the images are sent based on 
the desired matrix size and the amount of lossy compression that is acceptable.  The selections 
are: 

 
� DICOM – DICOM as exists on the Server 
� Lossless – DICOM JPEG lossless compression 
� High – Lossy JPEG highest quality, depending on the modality and the region of interest; 

this is set by the systems administrator, and can be adjusted based on need. 
� Good – Lossy JPEG good quality, depending on the modality and the region of interest; this 

is set by the systems administrator, and can be adjusted based on need. 
� Fast – Lossy JPEG, but lower quality for faster download, depending on the modality and 

the region of interest; this is set by the systems administrator, and can be adjusted based on 
need. 

 
� Change Password – Allows the user to enter a new password for use when logging into the 

BRIT Lite application. 
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Image 
 
The Image menu provides a variety of control mechanisms over the 
formatting of images which allows the user to decide how many images are 
simultaneously viewed on the screen, the window/level settings, rotation, 
annotations, navigation, turning presentation states on or off, turning image 
labels on or off, and utilizing scout lines.  A multiple image screen is referred 
to as a montage of images.  
 

Images Mag 
 
The magnification of the images can be changed by selecting Image Mag from 
the Image drop-down menus, and selecting the desire magnification levels.  The 
magnification choices include: 

� Fit – Resizes the image to fit completely in the current window, regardless of 
the size of the window. 

� X ½ – Resizes the image to one-half the size of the original image. 

� X1 – Displays the image in a one-to-one pixel ratio to the originally captured 
size of the image. 

� X2 – Displays the image twice the size of the originally captured size of the 
image. 

� X4 – Displays the images four times the size of the originally captured size of the image. 

 

Windows/Levels 
 
The window/level settings are selected by selecting Windows/Levels from the 
Image drop-down menus, and selecting the desired window level setting.   

The window and level settings allows the user to change the range of densities 
being viewed on the screen.  There are several actions that can be taken to 
change window and level settings, including preset values and manual settings.  
Window and leveling are the adjustments used for brightness and contrast 
control for the images.  Additional window/level setting can be added including: 

� Invert – Changes the window/level setting to the reverse contrast, 
sometimes referred to as blackbone setting. 

� Reset – Changes the window/level setting back to the initial settings. 

� Soft Tissue – Changes the window/level setting to the preferred setting for soft tissue. 

� Brain – Changes the window/level setting to the preferred setting for the brain. 

� Bone – Changes the window/level setting to the preferred setting for bone. 

� Lung – Changes the window/level setting to the preferred setting for lung. 
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Rotate/Flip 
 

Rotate allows the image to be rotated at 90° increments either clockwise or 
counter-clockwise.  Select Image from the drop-down menu and select 
Rotate/Flip, then click on the desired rotate or flip direction. 
 
The rotate/flip choices are: 

� Flip top/bot – Turns the image 180 degrees top to bottom. 

� Flip L/R – Turns the image 180 degrees left to right. 

� Rotate CW – Turns the image 90 degrees clockwise, or to the right, each 
time it is selected. 

� Rotate CCW – Turns the image 90 degrees counter-clockwise, or to the 
left, each time it is selected. 

 

Format 
 
The montage, or format of images, is changed by selecting Images and 
Format from the main menu and the following menu displays. 
 
The formatting choices are: 

� Stack – Opens up one window for each series in a study on the monitor, 
and places all the images in each series in a “stack” mode.  This means 
that all the images in the series are “stacked” behind the first image of 
that series.   

� 2/page – Displays two images in a one row by two column format on the 
page. 

� 4/page – Displays four images in a two row by two column format on the 
page. 

� 6/page – Displays six images in a two row by three column format on the page. 

� 9/page – Displays nine images in a three row by three column format on the page. 

� 12/page – Displays 12 images in a three row by four column format on the page. 

� 16/page – Displays 16 images in a four row by four column format on the page. 

� 20/page – Displays 20 images in a four row by five column format on the page. 

� 1 by 2 – Displays two images in a one row by two column format on the page. 

� 2 by 1 – Displays two images in a two row by one column format on the page. 

� All – Displays all of the images in the series on the page.  The system displays the image in the 
number of images in the series. 
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Annotations. 
 
There are a few types of annotations that are available for the users to mark 
and note the relevant areas in the region of interest.  These include 
measurements for distance and angles.  To do annotations, select Image 
and then Annotations, and the following choices are available: 
 
� On/Off – This allows measurements that have been done for the image 

to be displayed or removed from the image. 
� Angle – This allows the user to do measurements for angles. 
� Length – This allows the user to measurements for lengths. 
� Font meas – This allows the font to be changed for measurement text 
� Clear – This erases all the annotations that have been done on the 

image. 
 

Series Maximize 
 
The Series Maximize enlarges the selected series and displays it in a one-up format; it is the only 
series displayed. 
 

Next Series 
 
When multiple series are available for the study, this displays the next series in the study. 
 

Series Close 
 
This closes, or exits, the selected series, without closing the entire study. 
 

Study Maximize 
 
When multiple studies are displayed for the patient, this enlarges the selected study and displays it 
as the only study on the monitor. 
 

Next Study 
 
When multiple studies are available for the patient, this displays the next study in the list. 
 

Study Close 
 
This closes, or exits, the select study for the patient, without closing other studies for that patient 
that are open. 
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Presentation State 
 
Presentation State turns the previous annotations and markings on or off.   To turn 
on the feature, select Image and then select Presentation State from the Image 
drop-down menu.  If Presentation State is checked, the annotations are displayed, if 
unchecked, the annotations are turned off. 
 

Image Labels 
  
Selecting Image Labels turns the labels for the image on or off. To turn on the feature, select Image 
and then select Image Labels.   If Image Labels is checked, the labels are displayed, if unchecked, 
the labels are turned off. 
 

Scout/Synch Series 
 
Scout lines are used to determine the location of the images in one series compared to another 
(saggital to axial, for example) for MR and CT.  Scout 
lines can be used alone to reflect the position on the 
axial or saggital images in relation to the Scout 
image.  The Synch feature is typically used in 
conjunction, so that when one image is advanced, or 
zoomed in one series, all the synchronized series 
also advance or zoom in relation to the 
corresponding series, and the corresponding 
reference points are marked on each image.   
 
To turn on this feature, select Image, and then select 
Scout/Synch Series.  On one of the series, scroll to 
the next image, and the scout lines appear on the 
Topogram, as shown here: 
 
If Scout/Synch Series is checked, the Scout Lines are shown, and the series are synchronized.  If 
Scout/Synch Series is unchecked, the Scout Line are not displayed and the series synchronization 
is turned off. 
 

Reset All 
 
Selecting Reset all returns the images and series to their original state, removes all newly marked 
annotations that were not saved with the original study, and resets the window/level settings. 
 

Close All 
 
Selecting Close All exits all open studies for every patient. 
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Search 
 
The Search menu brings up the search window.   This 
allows the user to perform and advanced search for 
patients by various criteria such as Patient ID, Patient 
Name, Initial plus ID, Accession number, Study date and 
time, Body Part, Modality, Age, etc.  For further details on Searching for a patient, see the section 
called Using Search… on the Menu. 
 

Print 
 
The Print menu allows the user to print a hardcopy of 
either the Report or the Order for the selected study.  The 
Report and Order must be available for this to print. 
 
 

Help 
 
The Help menu provides some quick help on usage of 
BRIT Lite, the mouse, start-up procedure, the logs, and 
provides access to the full user manual.   
 
 
 
 
It also displays the version number and the release date of 
the BRIT Lite software. 
 
  

Quick Search Bar 
 
The Quick Search Bar allows a search for the patient to be performed.   
 

 
The criteria to search by include: 
 
� Patient Name – Patient first and last name 
� Patient ID – Patient identification number 
� Init+ID – Initial plus the last four digits of the ID number 
� Accession number – Number assigned for the study by the modality when the exam begins 
 
See the section Searching for a Patient or an Exam for further details on how to use the Quick 
Search Bar fields. 
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Patient Select/Work List 
 
When the entire patient list is displayed, the left window displays the Patient Select/Work List with 
the patient information, which includes: 
 

�  - Key Images Link – Identifies if 
Key Images have been selected for the 
patient.  See the section on Key 
Images for further details. 

 

�  - Reports Link – Identifies if 
Reports are available for the study or 
series.  See the section on Reports for 
further information. 

 

�  - Information Link – Displays the 
Patient Order information.  See the 
section on Information for further 
details. 

 
� Name – Shows the first and last name of the patient 
 
� ID – Shows the identification number of the patient 
 
� Date of Birth – Displays the date of birth for the patient 
 
� Sex – Displays the gender of the patient 
 
� Modality – Shows the medical device on which the study was performed 
 
� Region of Interest – Displays the area of the body where the study was performed for the most 

current patient study. 
 
� Date – Shows the date the study was performed 
 
� #Stu – Displays the number of studies for the patient 
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Study List Area 
 
The right side of the window displays the exam information with the most recent 
study expanded to show the thumbnails for the studies and series.  Below the 
most recent exam is a list of older studies for the patient.   This area contains the 
following information about the exams: 
 
� Date – The date the exam was performed 
 
� Modality – The medical device on which the exam was captured 
 
� Region of Interest – The body part on which the exam was performed 
 

�  - Key Images Link – Identifies if Key Images have been selected for the 
patient.  See the section on Key Images for further information. 

 

�  - Reports Link – Identifies if Reports are available for the study or series.  
See the section on Reports for further information. 

 

�  - Information Link – Displays the Patient Order information.  See the section on 
Information for further details. 

 
� Thumbnails – Small images showing the first image in the series or study 
 
� Description – Contains the study description 
 
� Accession Number – Displays the accession number assigned to the study by the modality 
 
� Report Snippet – Displays a fragment of the report for this exam 
 
Additional older studies are shown below with the Date of the Study, the 

Modality and the Region of Interest.  To open these studies, click on the  
to expand the study to show the thumbnails, description, accession number, 
and report snippet.   

If there are more than four additional studies, a  button is shown and 
indicates the number of additional studies that are available.  Click on this 
button to expand the list of studies for the patient. 
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Exam Viewing 

Study List 

Drop-down Menus 

Thumbnails 

Additional Exams 

Toolbar 
Buttons 

Exam Header 

Components of the Exam Viewing Window 
 
After the user has selected the patient, the sections of the Exam Viewing window change in some 
areas from the Patient Select window. 
 
This window contains four main sections: 
 
� Drop-down Menus 
� Toolbar Buttons 
� Exam Viewing Area 
� Study List Area 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Drop Down Menus 
 
There are five menus that provide additional functionality in the BRIT Lite application.  These are: 
 
� File 
� Patient List 
� Utilities 
� Image 
� Search 
� Print 
� Help 
 
See the section on Components of the Patient Search window for further descriptions of these 
Drop-down menus. 
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Toolbar Buttons 
 
There are a series of Toolbar buttons under the Drop-down Menus that allow additional functions to 
be performed on the selected image. 
 
 
 
 
 
 
The buttons on the Toolbar include: 
 

�  – Displays the next study that has been selected for the patient that is displayed in the 
viewing area.  The studies must be selected from the Study List area first. 

 

�  – Displays the next series that has been selected for this patient that is displayed in the 
viewing area.  The series must be selected from the Study List area first. 

 

�  – Moves to the next image in the series that is displayed in the viewing area. 
 

�  – Returns to the previous image in the study or series that was displayed in the viewing 
area. 

 

�  – Flips the image from top to bottom. 

�   – Flips the image from left to right. 
 

�  – Rotates the image 90° counterclockwise. 
 

�  – Rotates the image 90° clockwise. 
 

�  – Enlarges the image to fit to the size of the window for the viewing area. 
 

�  – Returns the image to the original one-to-one pixel size of the captured image. 
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�  – Magnifies the image to twice the original size. 
 

�  – Magnifies the image to four times the original size. 
 

�  – Returns the layout of the window to a one-up format in the viewing area. 
 

�  – Changes the layout of the window to show two images in the viewing area.  Depending 
on how the window is sized it could display two images in one column with two rows, or in two 
columns with one row.  If multiple studies are selected, then each pane in the window shows 
two images per page format in the study or series. 

 

�  – Changes the layout of the window to show four images in the viewing area.  The 
display shows two rows each with two columns.  If multiple studies are selected, then each 
pane in the window shows four images per page format in the study or series. 

 

�  – Changes the layout of the window to show nine images in the viewing area.  The 
display area shows three rows each with three columns.  If multiple studies are selected, then 
each pane in the window shows a nine image per page format in the study or series. 

 

�  – Changes the layout of the window to show all images for the study or series in the 
viewing area. If multiple studies are selected, then each pane in the window shows all images 
per page format in the study or series. 

 

�  – Returns the layout of the images to the original layout. 
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Exam Viewing (Image Viewing) Window 
 

The Exam Viewing (Image Viewing) window is the section to the left where the exams are viewed 
when a patient study, series, or image is selected.  It is divided into four main areas of information.   
 

First, a blue banner is shown that further describes the patient’s exam.  This contains: 
 
� Patient ID 
� Patient Name 
� Date of Birth 
� Gender 
� Number of Studies open 
 

The second is a green banner that further describes 
the study or series.  This banner contains: 
 
� Study Number 
� Modality 
� Region of Interest 
� Study Date 
� Exam Description 
� Number of Images 
� Number of Series 

 

The third is a blue banner that is above each individual image.  This banner contains: 
 
� Series Number 
� Body Part 
� Description of the Series 
� Number of the image in the total number of images in the series that is being displayed. 
 
The fourth is the area in which the images are displayed in the format selected from the Toolbar.  
This is where the exams are viewed, compared, measured, and manipulated.  There are a few 
additional features that are available by clicking various buttons on the mouse; however, most tools 
are available on the Toolbar.  See the section on Selecting Images for Viewing for more 
information. 
 

Study List  
 
The right side of the window is the Study List area, which contains the list of exams for the patient 
selected.  This section includes the: 
 
� Header Information – Includes the date of the exam, the modality, and the region of interest, 

along with the icons for Key Images, Reports, and Information 
� Thumbnails – Small images of an image in the study or series 
� Study Information – Includes the description, accession number, and report snippet 
� Additional older Studies – Displays only the header information including the date of the 

study, modality, and region of interest. 
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The most recent study is expanded to show:   
 
� Date of the Study 
� Modality – Medical device on which the exam was performed 
� Region of Interest – Body part on which the exam was performed 
� Thumbnails – Small representation of an image in the study or series 
� Description – Identifies the modality and the region of interest for the study 

or series 
� Accession Number – Displays the accession number assigned to the 

patient’s exam by the modality 
� Report Snippet – Displays a fragment of the radiologist’s report on the 

study or series 
 

By clicking on the  next to the older exams, the information is expanded for 
that exam, and displays the same information as the most recent study shown 
at the top of the study list.  For more details on the Study Lists, see the section 
on Selecting the Exam. 
 

Using the Mouse 
 
BRIT Systems recommends that a three-button mouse be used when working with the BRIT Lite 
application. 

 Generally a three-button mouse is recommended for use with the BRIT Lite 
application.  In most cases the: 
 

� Left button – Used to select the image, and move to the next image 
� Middle button – Used to control brightness and contrast  
� Right button – Used for special functions 

 
 

                        If a two-button mouse is the only type available, it can be used to duplicate the 
functions of a three-button mouse by using the: 
 

� Left button – Used to select the image, and move to the next image 
� Both buttons – Used to control brightness and contrast  

� Right button – Used for special functions 

 
Typically the users utilize the left and middle mouse buttons primarily during the viewing of 
images. 
 
The term "click" or “press” or “select” means to position the mouse pointer (or cursor) 
over the item of interest, then press the mouse button once and immediately release it. 
 
The term “left click” means to click using the left button on the mouse. 
 
The term “right click” means to click using the right button on the mouse. 
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The term “double-click” means to click twice quickly on the mouse button.  
The terms "drag and drop", "click and hold", or “press and hold” means that the left mouse 
button is pressed and held down over an item and the mouse is moved in the appropriate direction, 
then the button is released to leave the item where it is currently placed. This type of action is used 
to move items to another part of the window. 
 

The following table summarizes the various BRIT Lite functions that can be performed using the 
three button mouse.   

 

Left Mouse Button Middle Mouse Button Right Mouse Button 

Select menus, icons, and images 

(Click on the item) 

Set optimal window/level to set 
brightness and contrast 

(Click on image area of interest) 

Bring up pop-up menus to 
manipulate the image 

(Click on the image) 

Increment through a series of 
images 

(Click on the image) 

Adjust the gray levels in the image 
to set contrast. 

(Click on the image and hold the 
mouse button and drag left or 

right) 

 

Drag images up, down, left, or 
right. 

(Click on the image and hold the 
mouse button and drag the 

image to the desired location) 

Adjust the density range in the 
image. 

(Click on the image and hold the 
mouse button and drag up or 

down) 

To dynamically increment 
through a series of images. 

(Click on the image and hold the 
mouse button and drag up or 

down) 

 
      The following table summarizes the various BRIT Lite functions that can be performed using the 

two button mouse.   
 

Left Mouse Button Right Mouse Button Both Buttons 

Select menus, icons, and images 

(Click on the item) 

Bring up pop-up menus to 
manipulate the image 

(Click on the image) 

Set optimal window level to set 
brightness 

(Click on image area of interest) 

Increment through a series of 
images 

(Click on the image) 

 Adjust the gray levels in the 
image to set contrast. 

(Click on the image and hold the 
mouse button and drag left or 

right) 

Drag images up, down, left, or 
right. 

(Click on the image and hold the 
mouse button and drag the image 

to the desired location) 

To dynamically increment 
through a series of images. 

(Click on the image and hold the 
mouse button and drag up or 

down) 

Adjust the density range in the 
image. 

(Click on the image and hold the 
mouse button and drag up or 

down) 
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Chapter 2 – Searching for a Patient or Exam 
 
 
Users can log into the server and view patient lists and exams that are on the server, or work off-
line which only displays the patients that have been formerly downloaded to the local machine from 
a previous session. 
 
After the user has logged onto the system, the patient and the exam can be selected for viewing, 
measurements, manipulations, or comparisons.   
 

Using the Quick Search Bar 
 
Users can also search for the patient by the search fields in the Quick Search Bar on the main 
window.  There are several criteria and methods to perform a search, including: 
 

� Patient Name – Used to 
search for the patient via 
their Name by entering: 

 
� The full patient name  
� A portion of the Patient 

name if the exact 
spelling of the patient 
name is unknown 

� A list of all patients by 
entering an asterisk (*) 

� A wild card search for 
the beginning of the 
name, i.e., “SM*” to get a 
list of patients whose 
names begin with “SM”. 

� A wild card search for 
characters in the middle 
of the name, i.e., 
“HANE” to get a list of 
names that contain the 

         characters “HANE”. 
 
� Patient ID – Used to search for the patient via their Patient ID by entering: 
 

� The full patient ID  
� A portion of the Patient ID number if the full Patient ID is unknown 
� A list of all patients by entering an asterisk (*) 
� A wild card search for the beginning of the ID number, i.e., “11*” to get a list of IDs 

beginning with “11”. 
� A wild card search for characters in the middle of the number, i.e., “45” to get a list of IDs 

that contain the number “45”. 
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� Init+ID – Used to search for the patient via first initial of their last name plus the last four digits 

of their Patient ID by entering: 
 

� The first initial of their last name plus the last four digits of their patient ID 
� A list of all patients by entering an asterisk (*) 
� A wild card search for characters in the middle of the ID, i.e., “H18*” or “*H41*” to get a list 

of IDs that contain those characters, but there may be additional characters before or after 
the H18 and the H41. 

 
� Accession Number – Number assigned to the exam by the modality when the exam was 

started.  It cannot be changed, and it is not the same number as the patient ID. 
 

� The full accession number  
� A portion of the accession number if the exact number is unknown 
� A list of all patients by entering an asterisk (*) 
� A wild card search for the beginning of the number, i.e., “11*” to get a list of patients whose 

accession numbers begin with “11”. 
� A wild card search for characters in the middle of the number, i.e., “16” to get a list of IDs 

that contain the characters “16”. 

To search for a patient, enter the information in one of the fields and click on the  
button, and the results are displayed in the Patient Search window. 
 

Using Search… on the Menu 
 
Users can search for a patient by clicking on 
the Search... button at the top, and the BRIT 
Lite Patient Search window opens.   
 
A search for the patient can be performed by: 
 
� Patient Name – Used to search for the 

patient via their Name by entering: 
 

� The full patient name  
� A portion of the Patient Name if the 

exact spelling of the patient name is 
unknown  

� A list of all patients by entering an 
asterisk (*) 

� A wild card search for the beginning of 
the name, i.e., “SM*” to get a list of 
patients whose names begin with 
“SM”. 

� A wild card search for characters in the 
middle of the name, i.e., “HAR” to get a 
list of names that contain the 
characters “HAR”. 
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12121212    111100000000    

Acc# 502240807101000 

SarahSarahSarahSarah    

� Patient ID – Used to search for the patient via their Patient ID by entering: 
 

� The full patient ID  
� A portion of the Patient ID number if the Patient ID is unknown 
� A list of all patients by entering an asterisk (*) 
� A wild card search for the beginning of the ID number, i.e., “11*” to get a 

list of IDs beginning with “11”. 
� A wild card search for characters in the middle of the number, i.e., “45” to get a list of IDs 

that contain the number “45”. 
 
� Initial + ID – Used to search for the patient via first initial of their last name plus the last four 

digits of their Patient ID by entering: 
 

� The first initial of their last name plus the last four digits of their patient ID 
� A list of all patients by entering an asterisk (*) 
� A wild card search for characters in the middle of the ID, i.e., “H18*” to get a list of IDs that 

contain those characters, but there may be additional characters before or 
after the 18. 

 
� Age – Used to search for the age of the patient. Select the age range 

criteria from the drop-down menu and enter the age in the next field by 
selecting and entering: 

 
� Equal ( = )  – Select equal to and enter the specific age. 
� Greater Than ( > ) – Select greater than and enter the lower end of the 

age range.   
� Less Than ( < ) – Select less than and enter the upper end of the age 

range.   
 

� Gender – Used to search for the gender of the patient by selecting one of the following from the 
menu: 

 
� All – Select all patients regardless of gender. 
� Male – Selects all patients who have a gender status of Male. 
� Female – Selects all patients who have a gender status of Female.   
� Other –Selects all patients who have a gender status of Other.   
 

� Accession Number – Used to search for the patient via the number assigned by the modality 
when the study is started. 

 
� The full accession number  
� A portion of the accession number if the exact number is unknown 
� A list of all patients by entering an asterisk (*) 
� A wild card search for the beginning of the number, i.e., “11*” to get 

a list of patients whose accession numbers begin with “11”. 
� A wild card search for characters in the middle of the number, i.e., “16” or “*16*” to get a list 

of patient’s accession numbers that contain the characters “16”. 
 
 

H0224 
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� Study Status – Used to search for the patient via the current status of the patient’s study.  
Select the status from the drop-down menu.  Individual sites may have more study statuses 
defined based on use, but some of the most common include: 

 
� All 
� Examined 
� Critical 
� Read 
� Reported 
� Complete 
� Unmatched 
� Verified 
 

� Body Part – Used to search for the patient via the body part selected for 
the study.  Select the body part from the drop-down menu.  Individual sites 
may have different body parts defined based on use, but some of the most 
common include: 

 
� All 
� Abdomen 
� Ankle 
� Breast  
� Chest 
� CSpine 
� Foot 
� Hand 
� Knee 
� LSpine 
� Neck 
� TSpine 
 

� Modality – Used to search for the patient using the modality on which the study was performed.  
Select the status from the drop-down which can include CT (Computer Tomography), CR 
(Computed Radiography, or X-Ray), MR (Magnetic Resonance Imaging or MRI), NM (Nuclear 
Medicine), RF (Radio Fluoroscopy), and US (Ultrasound) to search for the medical device on 
which the study or series was performed. Individual sites may have more study modalities 
defined based on use, but some of the most common include: 

 
� CR 
� CT 
� MR 
� NM 
� RF 
� US 
 
 
 
 
 

Status 
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� Study Date and Time – Used to search for the patient based on the date and time 
the study was performed.  Click on the radio button next to the field and enter the 
specific data.  Searching for the study date and time can be based on: 

 
� Studies performed any date and time – Includes all studies 
� Studies performed within the last – Enter the number and select days or hours. 
� Study date between – Enter the range of dates for the study 
 
 

� Search Favorite – Used to select the preferred search from the criteria that were previously 
saved.  These are shown in the drop-down menu.  If one of the saved searches is no longer 

needed, click on the  button. 
 
� Name New Favorite – If a specific type of search is performed frequently, the 

search can be saved.  The Name New Favorite field is used to save the search 
criteria entered so that it can be recalled later without having to re-enter the 
search criteria.  To save the criteria selected, enter the name of the search in 
the “OR Name New Favorite” field and click on the 

 button.  The search criteria is now saved and can be 
reused at any time. 

 
� Maximum Results – Enter the highest number of patient names for the system to display as the result of 

the search in the field. 
 

Once the search information is entered, click on the  button and the results are 
displayed in the Patient Select/Work List area of the window  
 

To close the window, click on the  button. 
There are five buttons on the Patient Search dialog box, which are: 
 

�  –  Erases all information entered into any of the fields 

�  –  Performs the search for the patients based on the criterion entered in the fields 

�  –  Closes the Patient Search Window 

�  – Deletes the selected search criteria from the list. 

�  – Saves the entered search criteria with the name entered in the “OR 
Name New Favorite” field above. 

 
 
 
 
. 
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Icons on the Patient Search Area 
 
When the patient list is displayed, there are several icons on this window that the user can click on 
to obtain additional data.  These are: 
 

�   – Key Images – 
Indicates that there are 
images that have been 
selected as important or 
relevant to the exam.  When 
this is selected, the images 
appear in the Exam Viewing 
Area on the left.  See the 
section on Key Images for 
more details. 

 

�  – Reports – 
Indicates that the report is 
available and ready to be 
read.  When this Report icon 
is selected, the Patient 
Select portion of the window 
is divided in half, and the Report is shown in the lower half of this window.  See the section on 
Reports for more details. 

 

�  – Information – Indicates that the exam order information is available and can be 
viewed.  When this Information icon is selected, the Patient Select portion of the window is 
divided in half, and the Patient Order information is shown in the lower half of this window.  See 
the section on Order information for further details. 

 
To select the desired patient, position the cursor on the desired patient name, and click one time.  
The exams for that patient are shown on the right in the Study List Area.   
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Sorting the Patient List 
 
The patient list can be sorted by clicking one time on 
any column heading.  For example to sort by Patient 
Name, click on the Patient Name heading, or to sort 
by modality type, click on the Modality heading.   
 
To get an alphabetical list of patients by Modality, 
click on the heading for Patient Name, and then click 
on the heading for Modality. 
 
 
 
 

Selecting the Exam 
 
Once the desired patient is selected, all exams for 
that patient are shown in the Study List area.  The 
exams are shown in order by date, with the most 
recent exam showing thumbnail displays of the 
images for that exam. 
 
This section shows the Date of the study, the 
Modality, and the Region of Interest. 
 
For the most recent exam, along with the thumbnail 
images, it also shows the Description, the Accession 
number, and a snippet of the Report. 
 
Four additional exams are shown below by date.  To 

select one of these exams, click on the Plus ( ) 
icon to expand the exam and view the images for that exam.  

If more than four additional older exams are available for the patient, the  button is shown 
with information on the number of additional exams that are in the list.  Click on this button to 
expand the list to display all the exams for the patient. 
 

Selecting Images for Viewing 
 
There are several ways that the images in the exam can be selected for viewing: 
 
� Double-click on the Exam Header – the study Date, Modality, or Region of Interest titles for 

the study shown in the Study List window using the left mouse button. 
 
� Double-click on the Thumbnail for that study using the left mouse button. 
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� Drag and drop the Exam Header for the study into the Exam Viewing part of the window 
 
� Drag and drop the Thumbnail for the 

study into the Exam Viewing part of the 
window. 

 
Notice that the window changes to display 
more information about the exam. 
 
First, a blue banner is added that further 
describes the patient’s exam.  This contains: 
 
� Patient ID 
� Patient Name 
� Date of Birth 
� Sex 
� Number of Studies open 
 
The second is a green banner that further 
describes the study or series.  This banner 
contains: 
 
� Study Number 
� Modality 
� Region of Interest 
� Study Date 
� Number of series that is open 
 
The third is a blue banner that is above each individual image.  This banner contains: 
 
� Series Number 
� Description of the Series 
� Number of the images in the series that is being displayed. 
 

To expand the image to fill the viewing area for closer viewing, click on the  for that image (the 
upper right side of the image).   

To return the viewing area to the previous format, click on the  for that image (the upper right 
side of the image), and the original format is shown. 
 
To expand the window, and hide the Study List area, so that the entire window is available for the 

images, click on the .  To return the window so that the Study List appears again, click on the 

 and the window reduces to the original size, and the Study List is shown again. 
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To remove the image from the viewing area, click on the  for 
that image (the upper right side of the image), and the image is 
no longer displayed in the viewing area.  To get the image back 
into the viewing area, double-click on the image thumbnail in the 
Study List area to the right, or click on the thumbnail and drag it to 
the viewing area. 
 
Images from other studies or series can be viewed by opening 
the other study or series and clicking on the image or dragging 
the thumbnail to the viewing area. 
 

Key Images 
 

An icon for Key images ( ) can appear in any of 
three places: 
 
� Patient Select/Work List area 
� Exam Header  
� On the image itself 
 
Images that have been selected by the radiologist, 
that are identified as particularly important or relevant 
to the patient’s exam, are available when the Key 
Images icon is shown.   

Click on the  icon and the selected Key Images 
are shown in the Viewing Area.  The Radiologist’s 
comments are shown as a “yellow sticky” tab. 
 
Notice also that the notes for the key images 
appear as a “yellow sticky” note on the image 
tagged as a Key Image. 
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Order Information 
 
An icon for the Order Information 

( ) can appear in two places: 
 
� Patient Select/Work List area 
� Exam Header  
 

The  (Information) icon is 
available to display the Order 
information for the patient.  Click on 
this icon and the following information 
appears for the exam in the lower half 
of the Patient Study/Work List section 
or in the lower half of the Exam 
Viewing area. 
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Sorting the Exams in the Study List 
 
When the exam list for a patient first appears, it is sorted in chronological order by 
date, with the most recent study listed first.   
 
To sort the exams in order by Date, such as oldest exam first in the list, click on the 

 section in the Exam Header, and a triangle appears next to the 

title - .  The exams are sorted by the oldest date first in the list.   
 
To sort the exams in order by most recent exam first in the list, click on 

the  section in the Exam Header, and a triangle appears next to 

the , and the exams are sorted by the most recent  date first in 
the list.   
 
When the exam list for a patient first appears, it is sorted in chronological order by 
date, with the most recent study listed first.   
 
 
 

To sort the exams in order by Modality, click on the  heading above the 

Exam Header, and a triangle appears next to the title - .  The exams are 
sorted by Modalities in alphabetical order.   
 

To sort the exams in reverse alphabetical order by Modality, click on the  

heading above the Exam Header, and a triangle appears next to the title - , 
and the exams are sorted by Modality in reverse alphabetical order.   
 
 
 
 

 
 
 

To sort the exams in order by Region, click on the  
heading above the Exam Header.  The exams are sorted by Region in 
alphabetical order.   
 
To sort the exams in reverse alphabetical order by Region, click on the 

 heading above the Exam Header, and the exams are sorted by 
Region in reverse alphabetical order.   
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Chapter 3 – Changing the Layout  
 
 
The ability to change the layout of the study is accomplished easily in order to view 
other images in the study or to compare a previous study to a current study.  This 
is called changing the layout of the study or the series.  
 
Initially when the images are loaded into the Viewing area, it is shown as one image 
in the window.  The layout of the study or the series can be changed by: 
 
� Clicking on Images in the drop-down menus, selecting Format, and clicking on the desired 

layout. 
 
� Clicking on the desired layout from the Toolbar button 
 
� Right clicking on the image, selecting Format, and selecting the desired layout from the drop 

down menu 
 
� Dragging additional images into the viewing area from the current study or another study 
 
As additional series are selected, the viewing window changes to accommodate the new series.    
Therefore, if a second study or series is selected, the window is divided in half so that the images 
from both studies are shown.  If a third or fourth study is selected the window is divided in quarters 
so that all three or four studies are shown. 
 

Format 
 
The montage, or format of images, is changed by selecting Images and 
Format from the main menu and the following menu displays. 
The formatting choices are: 

� Stack – Opens up one window for each series in a study on the monitor, 
and places all the images in each series in a “stack” mode.  This means 
that all the images in the series are “stacked” behind the first image of 
that series.   

� 2/page – Displays two images in a one row by two column format on the 
page. 

� 4/page – Displays four images in a two row by two column format on the 
page. 

� 6/page – Displays six images in a two row by three column format on the 
page. 

� 9/page – Displays nine images in a three row by three column format on the page. 

� 12/page – Displays 12 images in a three row by four column format on the page. 

� 16/page – Displays 16 images in a four row by four column format on the page. 
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� 20/page – Displays 20 images in a four row by five column format on the page. 

� 1 by 2 - Displays two images in a one row by two column format on the page. 

� 2 by 1 - Displays two images in a two row by one column format on the page. 

� All – Displays all of the images in the series on the page.  The system displays the image in the 
number of images in the series. 

 

Using the Toolbar Buttons 
 
There are five buttons in the Toolbar that affect the layout of the images in the study or the series.   
 
 
These buttons are: 
 
 

�  – Returns the layout to a Stack mode.  
 

�   – Places two of the images in a two-up format side-by-side, or one above the other, 
depending on the number of studies selected.  

 

�  – Places four of the images in a four-up format of two columns and two rows. 
 
 
 

�   – Places nine of the images in a 
nine-up format, three rows with three 
columns, as shown to the right: 

 

�   – Shows all of the images in the 
series in the viewing window. 

 
 

�   – Returns the study to the original 
layout format. 
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The layout of the study images can be changed at any time by clicking on the desired format. 
 
 
 
 
 
If images from different studies are shown in 
the window, and the 4/pg Toolbar button is 
selected, each individual study will be shown 
in a four-up layout, as shown here. 
 
 
 

 
 
 
If images from multiple studies are selected, each 
individual image can be shown in a different layout 
by clicking on the image and selecting the layout, as 
shown in the example to the right: 
 
 
 
 
 
 

Using the Pop-up in the Viewer 
 
Since the Toolbar only provides the formats of 
one-up, two-up, four-up, nine-up, or All formats 
and occasionally a different format is desired, 
additional layouts are available by right-clicking on 
the viewing window, and a pop-up window opens 
as shown here: 
 
Select Format and a second menu opens to show 
a list of available formats.  Scroll down to the 
desired format, click on it, and the format changes 
to the selected layout.  The layouts available 
through this method include: 
 
� Stack 
� Two/page 
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� Four/page 
� Six/page 
� Nine/page 
� Twelve/page 
� Sixteen/page 
� Twenty/page 
� One by Two – this layout displays one column by two rows of images. 
� Two by One – this layout displays two columns in one row of images. 
� All – this layout displays all images in the study or series.  The format used depends on the 

number of images. 
 

Dragging Additional Images into the Viewer 
 
 
 
 
 
 
Dragging images from the current study or from another 
study into the Viewing area also changes the layout of 
the images.  The formats for individual studies can be 
changed by clicking on that specific study and selecting 
the desired format from the Toolbar or by right-clicking 
and selecting Format and the desired layout. 
 
The different studies are separated by a dark green 
border. 
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Chapter 4 – Navigation  
 
 
There are several ways to go to the next or previous image in the study, or in the series by using 
the mouse, the toolbar, drop-down menus, or pop-up menus. 
 

 
 

Moving to the Next Image  
 

 
Once the patient and image are selected, click the left mouse button on the image and 

the system advances forward to the next image, one image each time the left 
mouse button is pressed. 

 
 
 
On the Toolbar, click on to move to the next image, or click on  to move to the 
previous image. 
 

Moving to the Next Series 
 
Once a series is open, to move to the next series by 

clicking on the      button on the Toolbar.  
 
On the drop-down menu, select Image and select Next 
Series. 
 

Moving to the Next Study 
 
Select multiple studies for the patient.  Once multiple 
studies are open, to move to the next study, click on the   

   button on the Toolbar.   
 
On the drop-down menu, select Image and select Next Study. 
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Simulating Cine 
 

To simulate “cine” on a series of images, click on the image in the viewing area, 
hold the right mouse button down, and move the mouse down the window to move 

numerically through the images from the first image to the last.  Move the 
mouse up the window to move numerically through the images in the series 

from the last to the first image in the series.   
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Chapter 5 – Comparison Studies 
 
 
Images from different studies can be selected for 
comparison between an older image and a current 
one.   
 
To compare images in different studies, select the 
patient and open an image in the current exam. 
 
 
 
 
 
 
 

 
 
 
 

Click on the  next to the other exam containing the 
previous images to which the comparison will be made, 
to expand the study.  Double-click, or drag and drop 
the image to bring into the viewing area. 
 
 
 
 
 
 
 
 
 

 
Additional images from that study can be brought into 
the viewing area and compared by double-clicking on 
the thumbnail of the image, or clicking on the image 
and dragging it into the viewing area. 
 
 
 

To close the study, click on the  to close the exam. 
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If images from another study need to be brought 
into the viewing area for comparison, click on the 

 next to the desired exam containing the 
additional images to which the comparison will be 
made, to open the study.   
 
Double-click on the image to bring into the 
viewing area. 
 
Additional images from older studies can be 
brought into the viewing area in this manner, and 
all are arranged accordingly. 
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Chapter 6 – Manipulating the Images 
 
 
Images in the study can be manipulated in a variety of ways including: 
 
� Magnifying the Image 
� Rotating the Image 
� Flipping the Image 
 

Magnifying the Images 
 
Images in the study can be enlarged, or magnified, for easier viewing of the detail of the images.  
Typically when the image is first opened, the 
magnification selected is fit to the window 
size.   
 
There are three ways to magnify the image: 
 
� From the Toolbar 
 
� From the pop-up window 
 
� From the Image drop-down menu 
 
 
 
 
 
 
 
 
 
 
If the image is magnified, and is larger than the viewing area, click on the image with the left mouse 
button, hold the button down, and drag the image around the Viewing Area until the desired portion 
of the image is shown. 
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Magnify Using the Toolbar 
 
There are several magnification levels available through the toolbar, which include: 
 

�  – Enlarges the image to fit the 
page 

 

�  – Sets the magnification to the 
original size of the image 

 

�  – Enlarges the image to twice 
the original size of the image 

 

�  – Enlarges the image to four 
times the original size of the image 

 
To enlarge an image from the Toolbar, click on the image and click on the toolbar magnification 
level.  The image is resized to the magnification level selected. 
 

Magnify Using the Pop-up in the Viewer 
 
There are also a variety of magnification levels available by right-clicking on the image in the 
Viewer, and selecting Image Mag.  The available image magnifications sizes are: 
 

� Fit – Enlarges the image to fit the page 
 

� x½ – Decreases the size of the image by 
50%, or ½ the size 

 

� x1 – Sets the magnification to the 
original size of the image 

 

� x2 – Enlarges the image to twice the 
original size of the image 

 

� x4 – Enlarges the image to four times 
the original size of the image 

 

To enlarge an image from the Viewer, right-
click on the image, select Image Mag, and 
select the magnification level.  The image is 
resized to the magnification level selected. 
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Magnify Using the Drop-down Menu 
 
There are also a variety of magnification levels available by clicking Image in the drop-down menus, 
and selecting Image Mag.  The available image magnifications sizes are: 
 

� Fit – Enlarges the image to 
fit the page 

 

� x½ – Decreases the size of 
the image by 50%, or ½ the 
size 

 

� x1 – Sets the magnification 
to the original size of the 
image 

 

� x2 – Enlarges the image to 
twice the original size of 
the image 

 

� x4 – Enlarges the image to 
four times the original size 
of the image 

 
 
 
 
 

To enlarge an image from the Viewer, click on Image, select Image Mag, and select the 
magnification level.  The image is resized to the magnification level selected. 
 
 

Rotating the Images  
 
The images can be rotated clockwise or counterclockwise by using one of these three methods: 
 
� From the Toolbar 
 
� From the pop-up window 
 
� From the Image drop-down menu 
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Rotate Using the Toolbar 
 
The images can be rotated clockwise or counterclockwise by using either of the Rotate buttons on 
the Toolbar. 

 
 
 

Select the  button to rotate the image 

90° counterclockwise, or to the left, for each 
time the button is selected. 
 

Select the  button to rotate the image 

90° clockwise, or to the right, for each time 
the button is selected. 
 
 
 
 
 

 

Rotate Using the Pop-up in the Viewer 
 
The images can also be rotated clockwise or counterclockwise by right-clicking on the image, 
selecting Rotate/Flip.   
 
 
 
 
Select Rotate CCW to rotate the image 

90° counterclockwise, or to the left, for 
each time the button is selected. 
 

Select Rotate CW to rotate the image 90° 
clockwise, or to the right, for each time the 
button is selected. 
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Rotate Using the Drop-down Menus 
 
The images can also be rotated clockwise or counterclockwise by clicking on Image in the drop-
down menus, selecting Rotate/Flip.   
 

 
 
 
Select Rotate CW to rotate the 

image 90° clockwise, or to the 
right, for each time the button is 
selected. 
 
Select Rotate CCW to rotate the 

image 90° counterclockwise, or to 
the left, for each time the button is 
selected. 
 
 
 
 
 
 
 

 
Flipping the Images  
 
The images can be flipped top to bottom or left to right by using one of these three methods: 
 
� From the Toolbar 
 
� From the pop-up window 
 
� From the Image drop-down menu 
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Flip Using the Toolbar 
 
 
The images can be flipped top to bottom or 
left to right by using either of the Flip buttons 
on the Toolbar.  Each time the button is 
selected the image flips accordingly. 
 

Select the  button to flip the image top 
to bottom for each time the button is selected. 
 

Select the  button to flip the image left to 
right, for each time the button is selected. 
 
 
 
 

Flip Using the Pop-up in the Viewer 
 
 
 
 
The images can be flipped top to bottom or 
left to right by right-clicking on the image, 
selecting Rotate/Flip and selecting the 
appropriate direction. 
 
Select Flip top/bot to flip the image top to 
bottom for each time the button is 
selected. 
 
Select Flip L/R to flip the image left to 
right, for each time the button is selected. 
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Flip Using the Drop-down Menu 
 
The images can be flipped top to bottom or left 
to right by right-clicking on the image, 
selecting Rotate/Flip and selecting the 
appropriate direction. 
 
Select Flip top/bot to flip the image top to 
bottom for each time the button is selected. 
 
Select Flip L/R to flip the image left to right, 
for each time the button is selected. 
 
 
 
 
 
 
 
 
 
 

Adjusting the Window and Leveling Settings 
 
Window and leveling are the adjustments used for brightness and contrast control for the images. 
  

 
To manually adjust the Window (Brightness) and 
Leveling (Contrast) over the entire range of values for 

the image, hold the middle mouse button down and move 
the mouse, or hold both left and right mouse buttons down for       

the two button mouse. 
 
To select preset window/level settings, click on the Image drop-down menu, select window/level, 
and select the desired preset specification. 
 
To automatically get optimum Window and Leveling settings on the image, relative to the region of 
interest where the cursor is placed (either on bone or tissue), click with the middle mouse button, or 
click both left and right mouse buttons for the two button mouse.   
 

To return the image to the original setting or exam layout, click on the Toolbar  button. 
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NoteNoteNoteNote::::    

 

Chapter 7 – Annotating the Image 
 
 
Measurements can be done for Angles and Lengths of the image, and different fonts 
can be selected as desired.  Annotations can also be turned on and off for the image. 
 

Measuring an Angle 
 
Angle measurements can be done by positioning the cursor over one area of the part 
to be measured, drag the mouse down to the lower end of the measurement, and 
release, then hold the mouse button down again and drag the mouse to the third end of 
the area to be measured for the angle. 
 

Measuring an Angle using Image���� Annotations 
 
Angle measurements can be taken after selecting 
Image, and Annotations, and Angle.  Once the 
angle measurement is turned on, the cursor 

becomes a small protractor tool .   

Position the top left of the  at one area of the 
part to be measured, drag the cursor down to the 
lower end of the measurement, and release, then 
hold the mouse button down again and drag the 
cursor to the third end of the area to be measured 
for the angle.  The lengths and the angle 
measurements are shown. 

 

 
Remember that these annotations are not saved back to the original image 
on the server. 
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NoteNoteNoteNote::::    

Measuring an Angle Using the Pop-up Window 
 
 
 
Angle Measurements can also be taken by right-
clicking on the image, selecting Annotations, and 
selecting Angle.  A small protractor tool appears. 

 
 
Position the cursor at one area of the part to be 
measured, drag the mouse down to the lower end of 
the measurement, and release, then hold the mouse 
button down again and drag the mouse to the third end 
of the area to be measured for the angle. The angle 
measurement is shown on the image. 
 

 

 
Remember that these annotations are not saved back to the original image 
on the server. 

 
 
 

 

Measuring Length 
 
Length measurements can be done by positioning the cursor over one end of the 
area to be measured, and drag the mouse down to the length that needs to be 
measured, and release the mouse. 
 
 

Measuring Length using Image���� Annotations 
 
Length measurements can be taken after selecting 
Image, Annotations, and Length.  Once the Length 
measurement is turned on, the cursor becomes an 

, position the cursor at one area of the length 
to be measured, drag the mouse down to the lower 
end of the measurement, and release. 
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NoteNoteNoteNote::::    

Measuring Using the Pop-up Window 
 
Length measurements can also be taken by right-
clicking on the image, selecting Annotations, and 
selecting Length.  The cursor becomes an 

.  Position the cursor at one area of the 
part to be measured, drag the mouse down to the 
lower end of the measurement, and release, then 
hold the mouse 
 
 
 
 
 

 
 
 
The Length measurement is shown on the 
image. 
 
 
 
 
 
 
 
 
 

 

 
Remember that these annotations are not saved back to the original image 
on the server. 

 
 
 

 

Erasing Annotations 
 
The annotations made by the user logged in can be erased by selecting Image, 
Annotations, and Clear.  This does not affect annotations saved previously by the 
Radiologist, Technologist, or other clinician using BRIT Vision or BRIT ViewThi 
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Turning Display of Annotations On or Off 
 
Annotations are the measurements for the angles or lengths that have been selected and 
measured, and are saved as a Presentation State.  These can be shown or hidden depending on 
what the users want to view. 
 
 

Using Image ���� Annotations 
 
 
 
This feature allows the user to hide the 
annotations from the image for better viewing.   
If the Annotations are displayed, click on 
Image, and select On/Off.  The annotations are 
removed from the image.  
 
To restore the annotations, click on Image, and 
select Annotations and select On/Off, and the 
annotations are shown on the image. 
 
 
 
 
 

 
 

Using Pop-Up ���� Annotations ���� On/Off 
 
 
 
The annotations can be hidden by right-clicking 
on the image, selecting Annotations and 
selecting On/Off.  Annotations can be shown 
again by right-clicking the mouse, selecting 
Annotations, and selecting On/Off.  This 
displays all the annotations that have been 
made. 
 
Selecting Annotations On/Off a second time 
hides the annotations that have been made. 
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Selecting the Font for the Annotations 
 
The font can be selected for the annotations by selecting 
Image, selecting Annotations, and selecting Font meas, or 
by right-clicking on the image, selecting Annotations, and 
selecting Font meas.  
 
The Font window opens up to allow the user to select the 
font that will be used for the annotations. 
 
Select the Font, Font Style, and Size, then click on OK.  The 
next time a measurement is taken, the new font applies. 
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Chapter 8 – Reports 
 
 

If the reports are available for an exam, the Report icon ( ) is shown in one of two places: 
 
 
 
� On the Patient Select/Work List 

window in the icon section 
 
� In the Study List in the Exam Header 

section 
 
 
 
 
 
 
 
 
 
 
 
 
 

Viewing the Report in the Patient/Select Work 
List 
 
 
To view the report, click on the Report icon 

( ) to the left of the patient name in the 
Patient/Select Work list.  The bottom section 
of the Patient/Select Work List opens to 
display the report. 
 
The report in this window should not be 
resized but can be moved to another part of 
the window. 
 

Click on the X to close the report window. 
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Viewing the Report in the Exam Viewing 
Window 
 
When the exam is shown in the Exam Viewing part of the window, if a report is available, click on 

the Report icon ( ) in the Exam Header in the Study 
List part of the window.   
 
A separate window opens to allow the user to view the 
report.   
 
This separate window can be resized and moved 
anywhere by dragging and dropping it to the desired 
area of the window.  
 

Click on the  to close the report window. 
 
 
 
 

Printing the Report 
 
Once the report is available, the user can print 
the report by opening the patient and the report, 
selecting Print and selecting Report from the 
drop-down menus. 
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Chapter 9 – Other Utilities 
 
 
There are several other actions that can be performed that are found in the Utilities drop down 
menu.  These include: 
 
� Hide/Show Study List 
� Download Status 
� Compress Quality 
� Change Password 
 

Hide/Show Study List 
 
 
This feature is on the Utilities drop-down 
menu, and allows the viewing window to be 
expanded to accommodate a larger viewing 
area.  If the Study List is shown, click on 
Utilities, and select Hide Study List.  The Study 
List disappears and the image is expanded to 
the full size of the window, as shown below: 
 
If the Study List is hidden, click on Utilities, and 
select Show Study List.  The Study List 
appears and the image is reduced to the size 
of the viewing window, as shown to the right: 
 
 
 

 
 
 
 
 
 
 
Another way to hide the Study List is to 

click on the  in the top blue bar above 
the viewing area.   To show the Study List, 

click on the  to display it again. 
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Download Status 
 
This selection displays the Downloaded DICOM files, the list of 
DICOM files to be downloaded, and the failed DICOM 
downloads. 
 
 
 
 
 
 
 
 
 
 
 

Compression Quality 
 
Compress Quality – Allows the user to control the compression 
class on a case-by-case basis for the images depending on the need 
for teleradiology consultation.  The selection is based on the 
transmission speed between the sending and receiving sites.  
Typically the images are sent based on the desired matrix size and 
the amount of lossy compression that is acceptable.  The selections 
are: 
 
� DICOM – The DICOM files as exist on the server. 
 
� Lossless – DICOM JPEG lossless 

compression. 
 
� High – Lossy JPEG highest quality, 

depending on the modality and the region of 
interest, typically this is set by the systems 
administrator, and can be adjusted based on 
need. 

 
� Good – Lossy JPEG good quality, depending 

on the modality and the region of interest 
typically this is set by the systems 
administrator, and can be adjusted based on 
need. 

 
� Fast – Lossy JPEG, but lower quality for faster download, depending on the modality and the 

region of interest, typically this is set by the systems administrator, and can be adjusted based 
on need. 
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Change Password 
 
This feature allows the user to change their individual 
password.   
 
 
 

 
To change the Password, click on Utilities and select 
Change Password.  The Change Password window 
opens.   
 
Passwords must be les than 16 characters in length, 
with at least two of the characters being alphabetic.   
 
Enter the new password, and then confirm that it is 
entered correctly by keying in the new password 
again.   

Select , and the password is changed.  
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Chapter 10 – Scout Lines/Synchronization 
 
 
Scout Lines and Synchronization are typically used in 
conjunction, so that when one image is advanced, or zoomed 
in one series, all the synchronized series also advance or 
zoom in relation to the corresponding series, and the 
corresponding reference points are marked on the topogram 
or Scout.   
 
 

Turning on Scout Lines 
 
Scout lines are used to determine the location of the images in one series compared to 
another (saggital to axial, for example) for MR and CT.  Scout lines are used alone to 
reflect the position on the axial or saggital images in relation to the Scout image, to 
display the corresponding plane of interest in the series as compared to the Scout 
image.   
 
Scout lines can be used as a stand alone feature, such that when the user left-clicks on the area of 
interest in the Scout image, the other series is adjusted to 
display the corresponding plane of interest.  To use scout 
lines, follow these steps: 

1. Select the patient and exam, and display the study on 
the monitor. 

2. Format the series as desired. 

3. Turn the Scout lines on by selecting Image and 
Scout/Synch Series. 

 

 

 

4. Click on the desired location in the 
image. 

5. The Scout line on the scout image 
displays the relationship of the 
selected image to the Topogram or 
scout, and the images are 
synchronized so that when one 
image is advanced the synchronized 
image is advanced as well. 
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Turning off Scout Lines 

Scout lines can be turned off by selecting Image and Scout/Synch Series.  When the� 

� is removed, the Scout Lines and synchronized images are turned off.  
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Chapter 11 – PDI Import 
 
One of the new features of BRIT Lite is the ability to import studies from a CD that 
a patient has brought in.  This section describes how to import these studies. 
 

Importing Studies from a CD 
 
To import a study from a CD, select the “Read DICOM PDI 
CD” from the File drop-down menu, as shown here: 
 
 

 
 
 
 
 
The DICOMDIR Scan window opens.  Click on 

the  button, and the Browse for 
Folder window opens, as shown below:  
 
 
 
 
 
 
 
 

 
Click on the CD Drive and the patient is brought into the 
DICOMDIR window, as shown here: 

 
 
 
 
Click on the � to select the patient, and notice a 
� appears in the box.   
 

Click on the  button. 
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NoteNoteNoteNote::::    

 
 
 
The patient is shown in the BRIT Lite window. 
 
Double click on the Study List header to view all series 
or images in the study, or drag and drop each of the 
series or images into the viewing area to view individual 
series or images. 
 
 
 
 
 

Saving Imported Studies to Hard Drive 
 
For workstations configured appropriately for saving the PDI CD 
studies to a hard drive, the “Save PDI CD to disk” is available; 
otherwise, it is greyed out.  To save the imported study to the 
hard drive, once the study is downloaded and images are 
available, click on the “Save PDI CD to disk” selection from the 
File drop-down menu. 

 
 
This selection is not available (greyed out), even on configured workstations, 

until the study has been loaded to the client (BRIT Lite). 
 
 

The “Save DICOM PDI CD to Hard Drive dialog window opens, as shown here: 
 

 Click on the  button. 
 
The system now begins copying the images to the hard 
drive, and displays a count of the images as they are 
copied, as 
shown here: 
 
 
 
 
 
 

 
 
When all images are copied this window disappears. 


